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Installing CCP on Vista or XP PCs

You Need a Personal Computer With a USB Port

CCP will run on any Pentium II or faster Windows PC. Your PC should be equipped with an adequate amount of

RAM for the operating system you use. CCP is compatible with the Windows 2000, XP and Vista operating systems.

It is not compatible with Windows ME, 98 or previous versions of Windows.

CCP is installed via a self extracting installer file downloadable from our installer only website:

www.urccontrolroom.com.



Installing CCP and Microsoft ActiveSync
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CCP installs with a companion program for communication, Microsoft ActiveSync.You must install both programs and

if un-installing, un-install both programs.To install the two programs, follow these steps:

1 Connect to our installer only website www.urccontrolroom.com and naviagate to Software Downloads,

then select CCP to download.

2 A file download Window will open. Click on OPEN.

3 The InstallShield Wizard Window for the CCP will open. Click on NEXT



CCP



4 The Install Destination Window will then open. Click on NEXT.

5 The Ready to Install Window will open. Click on INSTALL.

6 The program will install and then show that installation has been completed. Click on FINISH.

7 A new small window will open asking, "Install the Microsoft Active Sync 3.7". Click OK.



8 A new set up window will open for ActiveSync 3.7. Click on NEXT.
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Type iInnsSteaclltiniogn Title

9 A new window will open to select the installation folder. Simply click on NEXT.
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10 A new window titled "Get Connected" will open. Do not do click on any button in the “Get Connected”

window yet.
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The Get Connected

window will automatically update.

Do not click on NEXT.



11 Wait for the the Active Sync “Install” window to appear and then click “OK”.



12 At this point plug the USB cable into your computer and then the MX-6000 Remote.



13 The Get Connected Window will close and then a "Set Up a Partnership" Window will open. At this point

you are offered two choices. Warning! Installers should not choose Yes - This will set up a partnership

with that particular MX-6000. Every time the same MX-6000 is plugged in, it will automatically establish
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the connection, but it will not recognize new MX-6000s.

Always choose No - This is best for installers, as you will be programming multiple MX-6000's.This is

considered a "Guest" partnership. Each time that the MX-6000 is plugged in, it will open the get connected

window and the programmer will need to click "No" to establish a connection with the MX-6000.

After clicking No, the Microsoft ActiveSync Window will open and show that a "Guest" connection has

been established.



Keep Your Database Up to Date — USE LIVE UPDATE

CCP includes a vast library of IR codes for hundreds of brands and models of A/V components.This database is constantly growing with the inclusion of new devices every month. Keep your software up to date by using the Live

Update feature. Rather than un-installing and re-installing the software, you download updates to the software from

the internet. Simply follow these steps:
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1 Connect to the Internet normally.

2 Open CCP.

3 From the Communications Menu, select Live Update.

4 In the Live Update window, click on “OK” to start the update prcoess. The process will automatically

close CCP.

5 Wait for the progress window to indicate “Update Done”, then click on “OK”.

6 CCP is automatically restarted and ready to go. There is no need to restart Windows.
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Introducing CCP - The Complete Control Program for MX-980 and more...
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Main Menu and Toolbar

B
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Macro Window



A



Menus and Shortcut buttons for common tasks. The Program Menu activates each task in the correct order.



B



Home Designer and Model Designer Tree Views of the MX-6000 configuration. Double clicking on any page

enables you to quickly display that page on the simulator view. Right clicking on a device or page activates a

context menu.



C



The MX-6000 Simulate View is used to navigate and to select a button to program, edit or record a macro.



D



Multi-tabbed Tool window allows access to the “IR Navigator”, “Button, Page and Device Properties”, “Image

Gallery”, “Sound Gallery” and “Serial Database”.



E



The tabs select whether you want Properties or one of the tools displayed in the window above.



F



The Macro window is used to view and edit macros.
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Overview of the New Features of CCP

Complete Control Program represents a full house philosophy to programming, giving you tools to quickly program

multiple remotes in one file. You’ll find tree view is now split into two areas, one area called House Designer, which

enables you to select remotes or base stations based on what room they are in.



To configure a remote or a base station, you must DOUBLE CLICK it in Home

Designer.



The selected remote or base station is then placed into the Model Designer tree

view.To configure properties or a particular remote control page, DOUBLE

CLICK it in Model Designer.



Once a remote is selected, clicking on the Program tab will reveal the standard URC programming steps. Simply move

from left to right in sequence to program the remote completely.



To add new rooms, remotes or basestations to your file, you can either:

1 Right Click on Home in House Designer and select Add Room.This will open the System Configuration

window.



OR
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New Features

2 Click on the Program tab and select “Configure Home” (House Designer) from the far left of the Program

ribbon.
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This will open the System Configuration window:
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NOTE: Drag remotes or base

stations on top of the room

to add to room. You cannot

drag to the items inside the

room directly.

It’s easier to just select the

product and the room and

click on the ADD button.



3 Once the House Designer window is open, simply drag rooms to “Home”, then drag remotes and/or base

stations to each room as needed. See page xx for a detailed explanation.



TIP - Don’t add remotes to rooms until your first remote is finished.When adding remotes, you can copy the first

remote you’ve done, which will save effort on your second remote.
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Customizing the Workspace

CCP has some unique layout features that allow you to customize your own personal layout.

Here is the default layout: Home and Model Designer are on the left, the Simulator is in the middle, the Button

Properties window is in the upper right and the Macro window is in the lower right.
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You can always get back to the default layout by using the “Default Layout” button in the “Window” tab.
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All Windows in the Default Layout can be resized

To resize a window, move the mouse cursor to the side, top or bottom edge of the window.When you’re in the right

place, the windows “Resize Window” icon will appear. Next, hold down the “Left Click” button on your mouse and

drag the edge to make the window larger or smaller.
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All Windows in the Default LAyout can be Moved Around

To move a window to a new location, move the mouse cursor to the title bar of the window, hold down the “Left

Click” button on the mouse and drag the window to a new location.
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If you grab a window and drag it around the main layout, several new windows “Grouping/Placement Options”

appear. In the example below. I have moved the “Button Properties” window away from its default position on the

left side of the screen.Windows placement icons appear at the top, bottom, left and right side of the main window,

along with a windows grouping icon for the Macro window.
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If you move the “Button Properties” window to the middle of the screen, you’ll see a windows grouping icon for the

middle section of the screen.

If you move the “Button Properties” window to the right side of the screen, into the Model Designer window, you’ll

see a windows grouping icon for the Model Designer window.



Move the “Button Properties” window

into the middle of the screen
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Windows Grouping /Placement Icon

Windows snap into place when you drag the cursor / title bar of the window you want to move, into one of the five

options in the Windows Grouping Placement Icon.
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Place the new window above the existing window

Place new window into the

tabbed window grouping

Place the new window to the left

of the existing window



Place the new window to the

right of the existing window



Place the new window below the existing window



In the example to the right, the “Button Properties” window is being dragged into the “Place Above Existing

Window” icon on the left side of the screen.This will place

the Button Properties window above the Macro window.

Note: The yellow shaded area shows you where the new

window will appear, relatve to the existing window.

In this example, it will appear above the Macro window.
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Using the Window Auto-Hide Features

CCP has another layout feature that allows you to Float, Dock, Automatically Hide or Permanently Hide a window.
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Right click on the down arrow in the window title bar, a drop down menu appears with the following choices:

Floating, Dockable, Auto-Hide and Hide.

Floating: Allows the window to float anywhere on your conputers screen. It’s no longer confined to the CCP application window.

Dockable: Allows the window to snap to a location (Top , Bottom. Right side, Left side) within the confines of the

CCP application window.

Auto-Hide: Automatically hides the window to a toolbar at the Top, Bottm, Right side or Left side of the screen,

depending where the window is docked and provides a tab to access the window.The windows “Pin” icon in the title

bar is turned sideways conveying that the window is “No longer Pinned” in place.

Hide: Removes/ hides the window from the CCP apllication window.To restore the window, you must go into the

main toolbar and select the window from either the “View” tab or the “Tools” tab.



The Properties window “docked”.



The Properties window “hidden”.



Property window tab created when

this window has been set to “AutoHide”. To open the window, simply hover your mouse over the tab.

The window remains open until the

mouse is removed from it, then the

window auto-hides.
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Programming Tips

Move Left to Right on the Program Menu
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The Program Menu is your lifeline to a fast, easy programming experience. Follow the steps in the order shown in the

Menu for best results. Download and Test has been added to the Program toolbar.Typically, you will download to the

remote control several times throughout the programming process to test what you have done so far .You’ll also

need to download once you’ve completed all your final programming.

It is important to complete all of the tasks for each program step, before moving on to the next step, rather than

jumping back and forth and all over the place.
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Save a Device file and Import for faster programming

Archive and save your customized device files. Programming systems with similar components gets even faster when

you don’t have to redo your work over and over. You have your own ideas about how buttons should be labeled and

about how they should be arranged. You can save your work in a unique and time saving way if you save the customized device as a stand alone device file which you can import into any new configuration.
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Creating a New System File

Options - New or Existing Files

NEW - To start a new job from scratch, click on the “URC logo” and then choose “New” from the File

Menu. A Default file is created: One Room (Home Theater) and one MX-6000 Remote Control

OPEN - Allows you to open a configuration that you have worked on before and saved onto the PC hard

drive.

RECENT DOCUMENTS - The last four files you created in the CCP appear in a list to the right of the File

Menu.You can open oneof the files by double-clicking on it to resume working on the configuration or to

download the file to a MX-6000 remote control.
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UPLOAD - Get a file from a client’s remote control that another installer created. Now, you can save the

file to your laptop and make any edits or changes the client requested or the jobsite required.



New File - Step by Step

1 Click on the File menu tab and select “New” in the toolbar.



2 The “New File” window appears: Select “Default”, then select

MX-980 from the list box, finally click “OK”.
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CCP creates a new file with one room called “Home Theater” and one MX-980 remote control.
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Adding a BasTeypSetatinioSneucstio

ngn tThietleHouse Designer

3 Click on the “Configure Home” icon to add rooms or a Base Station(s) to the Home Theater.
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The “System Configuration” window appears: Drag and drop a MRF-350 Base Station into the room called “Home

Theater” in the Configuration Tree at the left. If you need to add more rooms
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4 Click on the “Properties” button, at the bottom left of the Configuration Tree, then set the MRF-350 Base

Station properties.
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The Base Station Model Properties window appears.

5 Select an RF ID from the RF ID drop-down list.

6 Name the Base Station.

Example: “Home Theater MRF-350”.

7 In the box to the right of each Flasher Port, enter

the name of the piece of gear that the flasher will

be controlling .

Example: Port 1 - AV Receiver

8 Click “OK”

9 Close the System Configuration window by

clicking on the “Close” icon in the upper

right hand corner of the window.
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10 Save the File. In the main toolbar, select “File” and then click on “Save As”.
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11 The “Save As” window appears. Enter a name for the new File, Example: “Smith Residence rev1” and then

click on the “Save” button.
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New Features for MX-980 in CCP

Undo via Control Z

CCP offers the UNDO feature, particularly useful when you are arranging artwork. Before beginning a large

amount of experimentation, click on save or save as. CCP will track all changes between saves or downloads

unless your PC runs out of memory (that’s probably too much experimentation between saves!).
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You’ll find Undo in the EDIT Menu, or you can use the keyboard shortcut Control Z.



Function View for Macro Programming

You can really speed up macro programming for repeated Activity Macros or Favorite Channels that utilize the

same devices over and over again. Simply choose Function View from the View Menu then click on the

devices you use over and over again (i.e. AV Receiver and Flat Panel TV), then arrange them around your

screen so that you can see the commands you’ll need.

Then start recording your macro. Instead of constantly going to tree view or the simulator to select the devices,

you simply click on the command you need.



NewOpenArchitecture

Features for MX-980

Editing

in CCP
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The Create and Name Devices Window

The new Create and Name Devices window is opened via the Program Menu and clicking on the icon on the left. Always work from left to righ in the Program Menu.

The key feature you’ll use is the library of Left, Wide or Right buttons on the left. Simply select the name of the

icon you like and drag it to the page displayed on the right from the alphabetical list.
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The Create &amp; Edit Layouts Window

The new Create &amp; Edit Layouts window is opened via the Program Menu

and clicking on step two.

After selecting either the Watch or Listen tree, you select the Device in the

template that needs pages added or overwritten, select the new template,

then select the button layout you want. You complete the process by clicking on Add Pages to add a new layout of many pages to an empty device or Overwrite pages to overwrite existing layouts.
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OpenArchitecture and Color



The MX-980 adds color to your arsenal of tools to make using an Audio Video system intuitive and entertaining to the client. CCP’s MX-980 Editor is engineered to give you immediate access to view and analyze a customers system, plus give you the structure to efficiently create a new configuration to add a new feature to the

client’s system.
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Left, Right and Wide Artwork Points to the LCD Button

To encourage the client to press the button not the screen, all the

artwork for the LCD buttons points to the button.

Built in features of the editor aid you in placing button artwork specifically for the left side of the screen or for the right side of the screen.

Additionally, for important features you’d like to emphasize to your

client, you have the option of “Wide” buttons that are operated by

either the left or the right button.



Templates with Built-In Programmer Conveniences:

MX-980 Editor installs with two templates included. Alpha has very

attractive icons and different backgrounds on every page. However, if

you would like to build a very large file with a few dozen or more

devices, the graphics limit maximum file size. Thus, there is a Text

Only template for large files.

If you would like additional templates, download the Extended Graphics set.

1 Each template is available in a starting configuration

with Default (1 Room, 1 Remote), Empty (No Rooms, No Remotes),

and Open existing file as a template. You canstart by creating your

system from scratch or by deleting devices from a larger file.

2 Additional templates can be downloaded from URC’s installer-only

website (www.urccontrolroom.com) in the form of a self-installing

Extended Graphics set, which automatically installs more templates

in the default location:

C:\Program Files\Universal Remote Control, Inc\Complete Control Program\MX-980 folder.



3 Each template includes an animated and customiz- Animated Timer Rotates While Macro Runs

able Please Wait screen for macros that take time. Simply program a jump to the Please Wait screen

at the beginning of the macro and a jump to the actual destination page at the end of the macro.



4 Macros are pre-programmed in each Favorite Channel Button in the Message is completely customizable

templates, enabling you to program favorite channels very conveniently using the Alias window. Just double click on the Alias step, then click once on the correct

digit.
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CCP’s MX-980 Editor Window



A



Main Menu and

Toolbar

B
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Designer



D
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Tool
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E

F



Model

Designer



Simulate &amp; Page View Work

Area



Macro

Window
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Menus and Shortcut buttons for common tasks. The Program Menu activates each task in the correct order.



B



Home Designer and Model Designer Tree Views of the MX-980 configuration. Double clicking on any

page enables you to quickly display that page on the simulator view. Right clicking on a device or page

activates a context menu.
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The MX-980 Simulate View is used to navigate and to select a button to program, edit or record a macro.

Page View enables you to re-arrange buttons on a page and to view the graphics life size.

Multi-tabbed Tool Window allows access to the “IR Navigator”, “Button, Page and Device Properties”,

“Image Gallery”, “Sound Gallery” and “Serial Database”.

The tabs select whether you want Properties or one of the tools displayed in the window above.

The Macro window is used to view and edit macros.



F



The important thing to remember as you program is that most Windows conventions hold true in all

URC Editors. Explore the program menus. Hover your mouse over most of the buttons and controls

and a balloon will appear with a hint as to purpose. Navigate around the program window and

explore a little before you begin programming.
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Programming Overview



A. New File, Existing File on PC or in Remote
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NEW - Starting from scratch on a new job, go to the File Menu, choose New from the File Menu and

pick either the default file or a blank file. The default template is pre-programmed with IR commands

and is useful for quick testing, but everything will have to be reprogrammed for your system. A blank

file is completely empty. It is really personal preference which way you start.

OPEN - Open a configuration that you have worked on before and saved onto the PC hard drive.

UPLOAD - Get a file from a client’s remote control that another installer created. Now, you can save

the file on your laptop, make any edits or changes as the client requests or the jobsite requires.



B. Use SAVE AS

The templates files are simply configuration files that have been preprogrammed for you. They will keep any

changes you make. Utilize Save As to make a new file with a new file name. All configuration files are saved

with the file extension .mxa.

TIP — Always use File | Save As to rename the file before doing any programming!

Use the customer’s name and a rev # (i.e. SmithTheaterRev1.mxa)



C. Use the Program Menu

The Program Menu is your lifeline to a fast, easy programming experience. Follow the steps left to right as

shown in the Menu for best results. Typically, you will

download to the remote control several times throughout this process and test what you have done so far.

You’ll need to download after finishing all programming. For macro playback to work, you need to have downloaded. These downloads are not listed in the steps here in the Program Menu and are not automatically done

for you.



D. Edit Button Layouts using Page View and NEW Keyboard Shortcuts

Moving buttons requires care, because MX-980 artwork is always either Left facing, Right facing or Wide (linking two buttons together). The best way to move buttons around is in Page View (selected from the View

Menu). Double click on each page you want to re-arrange, then drag the pages so that you can view all of

them. Now, utilize the keyboard shortcuts to re-arrange buttons by SWAPPING them:

1 Both buttons are on the same page and the same side. Simply drag either button to the position of

the other button. If they are on different pages but the same side, hold down the ALT key and drag

either button ot the position of the other button.

2 Both buttons are on the same page but on opposite sides. Hold down the SHIFT key and drag either

button to the position of the other button. If they are on different pages and on opposite sides, hold

down both the ALT and the SHIFT keys and drag either button to the position of the other button.



E. Save and Reuse Customer Files via Import Devices

Archive and save your customer files. Programming systems with similar components gets even faster when

you don’t have to redo your work over and over. You have your own ideas about what buttons should be

labeled and how they should be arranged. You’ll save all of your work and reuse it on the next job with similar components and devices by using the Import Devices feature.
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Creating, Naming and Arranging Devices

A device is the basic grouping of a set of hard buttons and as many LCD button pages as the MX-980’s memory allows. You will need one device group for each remote control that the MX-980 is replacing. When you

create devices in the Create and Name Devices window, every device is automatically linked with a jump-link

to the device via either the WATCH or the LISTEN menu. If you create devices manually in tree view (by right

clicking either Watch or Listen and selecting Add New Device) you have to create a jump link from either the

WATCH or the LISTEN menu button to each device manually.



Create and Name Devices Window

You can open the Create and Name Devices window by

clicking on the first item of the Program Menu:
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1 Step 1, after the Create and Name

devices window appears, select

the WATCH or the LISTEN menu

from the Target list box.

2 Step 2, select the theme you’d like to use from

the list box showing all themes installed.



3 Now, take a look at the page to the left. Where are you going to put the Device Icon? You must

choose from three separate icon styles, the LEFT side buttons, the RIGHT side buttons or the WIDE

style buttons. Click on the icon style you need for this button position.
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4 Use Step 3’s alphabetical list to

find the icon you want. Drag

from the alphabetical list to the

page on the left.

Use the keys on your keyboard

to go to the icon you need (i.e.

click on H to see the HDTV icon.

5 You must hit the SAVE button

to create all the new devices.
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Create Button Layouts for Devices and Activities

The Button Layouts window enables you to quickly create new device layouts using any of the twelve templates. Each device type (i..e. TV, DVD etc.) has an exact equivalent in each template, so you can freely experiment with different template designs before you program or create your own custom labels.
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Caution! You will lose any custom labeling if you Overwrite a device. Do your custom labeling after you’ve

decided on a template.

1 Create devices first - before you try to Add or Overwrite Pages. Devices must exist as a placeholder

for pages of button layouts. See Page 5 for information on Creating Devices.

2 Empty Devices or Fully Programmed Devices - The ADD function will add an entire button layout,

with many pages to an Empty Device. The Overwrite function will change a button layout for a

device from one template to another. See Advanced graphics for instructions on creating templates of

your own that utilize the Overwrite function on Page XX.



Using the Create &amp; Edit Layouts Window

1 Open the Create &amp; Edit Layouts Window - Access the Create &amp; Edit

Layouts window by selecting Step #2 from the Program Menu.

2 Select the Device and the Template - Work from Left to Right. Start by selecting the Watch or Listen

group of devices, then select the device in your configuration, then select the theme.

The preview window will

display the selected

device’s existing pages

and the existing template, untill you choose a

new button layout. Once

you’ve selected a new

button layout, you’ll be

able to preview it.

However, if the existing

device does NOT have

any pages (an empty

device), you will not be

able to preview the new

template until you have

ADDED the pages.
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3 Select the matching type of Button Layout - Select the device category that is closest to your needs.

If the device has pages, you will be able to preview the new artwork in the preview window before

clicking on Overwrite. However, if your device is empty, you can only see the new artwork if you

click on the Add button.
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4 Click on Add Pages or Overwrite Pages - Click on Add pages if you have an empty device or if you

would like to add pages to the existing pages in the device. Click on Overwrite if you would like the

existing pages updated to the new style of template.
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Utilizing the IR Database



Applying a “Set” of IR Commands to each Device

1 Open the Database Window - Select IR Database from the Program Menu.
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2 Device - In the first list box, MX-980 Editor lists the names of the devices you’ve created and named

in your configuration. Select the device you would like to program from the list box.



2 IR Data From - Select the type or category of component (i.e. TV, VCR or DVD player) via the “IR

Data From” listbox.



3 Brand - Select the company that made the component (i.e. B &amp; K, Sony, Krell) by clicking on the

correct brand name in the scrollable Brand window.
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4 Model - Select the exact model number from the scrollable Model window.
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If the MODEL number isn’t there, DON’T test the other model numbers! Instead...

Scroll to the bottom of the list of model numbers for your brand. There you will find a number of “Inclusive”

Code Sets. These code sets are always labeled BRAND1, BRAND2 (i.e.. Motorola1, Motorola2). Each will

operate many different model numbers. Generally speaking, if your component is a recent model, test the

higher numbered Inclusive code sets first. Here’s what the inclusive code sets look like:
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5 Test the Code Set

A. Verify the MX-980 is charged and connect it to the PC via the USB port.

B. Point the connected MX-980 so that it is in range and within line of sight of the component.

C. Power On the component.

D. Select the model number or the Inclusive Code set in the model window.

E. Click on the Test button as shown above. The only code you can test is the Power command.

F. If the component DOESN’T power off, try the next Inclusive code set.

6 Once the component powers off, click on the Save button.



TIP - If you’d like to drag one code to a button or test one code, use the IR Navigator, page 11.
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MX-980

UsingProgramming

the IR Database

Manual

7 Continue with the rest of the devices you need by clicking on the NEXT DEVICE button and repeating steps two through eight.
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8 When you have finished all of your devices, click on the NEXT button.
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Finding Discrete Commands for Reliable Macros

Discrete Commands versus Toggle Commands

When a remote control’s only button to turn on and off a TV set is labeled Power, it is usually a “toggle” command. Test it by pressing the button twice. If the power button turns on the TV, then turns it off, it is a toggle

command. You cannot predict whether the component will power on or not. That is a big problem when you

are programming macros! Basically, your client will feel that the macro only works half the time, and will

probably blame you for the problem.

Discrete means that the function of the command is “separate and distinct” from any other function. On a

remote control with “discrete” power commands, there are two power buttons. One that only turns the component on, and another that only turns the component off.

The most commonly sought “discrete” commands are for power on, power off and for TV and Surround Sound

Receiver INPUT selection. These discrete commands will make your macros work every time for your customer.

“Secret” Discrete Codes exist for some components. Why are they secret? Because the manufacturer

wants the remote control that accompanies the component to have the simplest appearance (fewest buttons).

Since toggles reduce the number of buttons, they make the remote control appear easier to operate. Many

manufacturers understand the needs of custom installers and build their components to also respond to discrete codes. They distribute the discrete codes via service remotes, etc. For the first time, those codes are collected and integrated into our database.

Not all components respond to the discrete codes in the Database. A component has to be BUILT to

respond to discrete codes. The fact that other models from the same manufacturer do respond to discrete codes

is the reason the codes are added to a code set. However, some models will not respond, because the manufacturer did not build it to respond through budgetary considerations, time constraints or a simple oversight.



Use the IR Database Navigator to Find Discrete Commands

1 Click on the TOOLS menu then click on the IR Database Navigator.
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Finding Discrete

MX-980Commands

Programming

forManual

Reliable Macros

2 Select the IR DATA FROM (category of component), then the BRAND, then

the MODEL. If you do not see the model number, utilize the INCLUSIVE

CODE SETS (i.e BRAND1, BRAND2, etc). Once you see a command that

has a promising sounding name, click on it so that it is highlighted (selected),

then click on the TEST button. You can test any IR command in the list.
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3 When you find a command that you want, simply click and drag it to the

button on the page or the simulator view.
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4 After you’ve dragged it to its new position, the new label and a pre-programmed code flag (the

orange P) is placed on the button.
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TIP - Vary the number of REPEATS to sustain an IR command for a few seconds.

Many projectors require a two or three second burst to power on or off. You can program this to occur

without the customer having to press and hold the button for several seconds by utilizing the repeat

window in IR Database Navigator. Simply experiment with different numbers of repeats and test the

command until it works as you want it to. There is no predictable relationship between the number of

repeats and seconds from one brand to another, so start experimenting with 10 repeats and time the

burst. Once you’ve programmed a button with this extended IR command, you can use it in a macro.

The timed burst will occur as a single

macro step.



Use the Universal Browser to find Discrete IR Commands

Using the Universal Browser Window you can import LEARNED IR codes from a .ccf file, an .mxf file or an

.rcc file. You cannot import any kind of Database codes, only LEARNED codes.

On the internet, you can find many unusual discrete codes by browsing the files section of a website popular

with other custom installers:

www.remotecentral.com

You can often find discrete codes by posting at one of many other sites popular with custom installers by posting on an online bulletin board. If any other custom installer knows of a solution he/she will email a file to

you. Whether your download a file or if you are emailed a file from another installer, the Universal Browser

enables you to import learned codes into your MX-980 configuration.

After you’ve saved the file to your PC, you use the Universal Browser as follows:

1



Open the Universal

Browser by clicking

on the Universal

Browser icon in the

TOOLS menu.



2 Click on the File icon to navigate to the folder that contains the file you’d like to get codes from.
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Finding Discrete

MX-980Commands

Programming

forManual

Reliable Macros

3 Use Tree View to Navigate to the Panel containing commands you want. Click on the panel name in

Tree View to make the panel appear in Panel View.
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4 Click on a button in Panel View and the Action List view will reveal whether it has a Trigger code

(MSC-400), Learned code or Pre-Programmed Data.

5 Click and drag the button to the MX-980 simulator.



6 After you’ve dragged a command from the browser, the button will change

it’s name if it is a screen button. Both screen and hard buttons show the

appropriate flag (Trigger, Learned or Pre-Programmed)

after you’ve dragged to a button.

T - Trigger - Indicates an MSC Trigger Command

L - Learned - Indicates a Learned IR Command

P- Pre-Programmed - Indicates an IR command from

the URC database.

M - Macro - Indicates a macro is programmed.

PT - Punch Through - Indicates that the button is

“punched through” to another device.
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Test All Commands and Relabel for Easy Operation using ALT and SHIFT

MX-980 Editor Page View enables you to display multiple pages and drag and drop buttons from one

page to another. However, since the artwork for buttons on the right points to the right and art for the

left points to the left, you must use the correct keyboard shortcut (Hold down ALT and SHIFT) to drag

from one position to another.

Before programming any further, you should rigorously test all of the codes you have programmed

using the IR Database and label the buttons with names that the customer will find easy to understand. The best approach is to download, test all the commands, and as you test, use MX-980 Editor

to modify labels, and hide or delete unnecessary commands.

Download and Test While Arranging Buttons

Begin testing the codes you downloaded to the MX-980. Make sure that you test all buttons (hard

buttons and the LCD buttons on each page of every device). Don’t try to learn new commands yet,

wait until you can do all of them at once systematically. First you must delete commands that don’t

work and change the labeling so that your client instantly understands why you’ve made the button

available to them. Good practice is to simply delete commands that the client will never use, or to

arrange them on the last pages of a device. Certainly, your most important goal is to place the most

useful commands on the first page of a device, so that the client has everything they need without

pressing a PAGE button.

Using Page View to Relabel and Re-arrange Buttons

1



From the View Menu, select Page View Mode.



2 In Tree View, expand the device you would like to EDIT. In Tree View Double Click on each page of

the device to display them. You can have as many pages open as your screen size makes usable.
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Test All Commands

MX-980 Programming

and Relabel for

Manual

Easy Operation



Tip - After you’ve opened all the pages you want to edit, drag them into the positions you like.

Use the Window Menu to control the open page windows as follows:

Cascade - Arranges all open pages in the most

compact stack (best for small screens)

Arrange Icons - Minimizes all open pages

Close - Closes the selected page

Close All - Closes all page views.
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3 Arrange Buttons by Holding Down ALT and SHIFT then Drag and Swap Button Actions and Labels

without Swapping Art!!!

Your client will be much happier with pages that look consistent. If you simply drag a button to

swap to another, everything swaps, including the left or right facing artwork. If both buttons have

exactly the same art that’s great. Much of the time, however, the art is slightly different in each place.

So you need to be able to swap a button’s label and action list (which includes the IR command or

macro you’ve programmed on the button). The SHIFT button lets you do that. The ALT button lets

you swap buttons from one page to another. Here’s a recap:

No Keys Held Down - Dragging and dropping over another button only works on the same page.

Everything is swapped: the art, the label and the action list. Only useful if

swapping one left button for another left button or one right button to another

right button.

ALT Key Held Down - Page to page dragging and dropping. Everything is swapped: the art, the label

and the action list. Only useful if swapping one left button for another left

button or one right button to another right button.

SHIFT Key Held Down - Dragging and dropping over another button only works on the same page.

Only the label and the action list are swapped.

ALT and SHIFT Key Held Down - Dragging and dropping over another button works page to page.

Only the label and the action list are swapped.

4 Label Buttons as needed - First, select the button



Second, type into the

Normal Text window.



The text controls enable you to type in multiple lines and space the text relative to the button art,

using the vertical/horizontal alignment tools. However, for the best appearance, it is often necessary

to use the SPACE bar before a word.



TIP - To move a text label away from a button edge, click before the word and use the SPACE bar.
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5 Repeat Steps 2-4 and continue to test all commands for all of your devices by double clicking in

Tree View, then editing the pages as needed. If you are missing a command and need to learn it,

delete any buttons that you don’t need and relabel to prepare for learning.



Tip - Move important commands to the first page of the device/activity.

Hiding Pages in Page View

A hidden page is accessible during programming so you can teach commands to buttons on hidden

pages and use them in macros. The interesting thing about hidden pages is that the end user cannot

manually access the page using the PAGE button. You HIDE pages by right clicking on a device in

Tree View, then selecting Hide from the context menu that appears.
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After you’ve hidden a page, the page is greyed out in Tree View.

Page 1 is Not Hidden



Page 2 is Hidden



Page 3 is Not Hidden, but it is about to be changed to Hidden (menu

is revealed when you right click on a page) by clicking on Hide in

the context menu.
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Learning



Learning should be a last resort for professional installers. We make every effort to provide you with

any codes you need via our database. If they are not, please make a note to email us at the first

chance with the learned file you created, the type of device it is and the Brand and Model Number. If

it is not a current model component, we would still like to add it to the database, but please note in

your email the approximate age of the component. Please address your emails to:
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IRDatabase@universalremote.com

Tips for Learning from Unusual Devices

When you have difficulty successfully teaching codes to the MX-980, always try these tips in the order below:



1. Fresh Batteries in the Original Remote Control - Weak batteries will cause MX-980 Editor

to fail to correctly learn. Note that EVEN if the original remote still operates the component,

the batteries can be too weak to produce a strong enough carrier for any learning remote control to detect!!!! When a code fails, replace the batteries FIRST!

2. Tap instead of Pressing and Holding - With buttons that the client will only tap when using,

this may produce better results. Normally, you should press and hold.

OR

2. The “Flutter” Technique - If you are having problems with a Code that has to be sustained

(like volume up or down), sometimes fluttering the button on the original remote at least seven

times while you are learning will successfully teach the code.

3. Vary the Distance between the Remote and the Learning Sensor - We recommend that you

start with a distance of half an inch between them. If no other technique works, try varying the

distance by doubling it each attempt. Keep trying until you are at least 5 feet away.

4. Try Standalone Learning, see page 23.

5. Call our technical support department at 1-800-901-0800 to see if they have a cross reference for the brand and model you are using. If there isn’t a cross reference, they will ask

you to ship the remote to our engineers so the codes can be added to the database.

Learning IR Codes One at a Time

When all you need is a code or two, this is the method to use. If you need to teach an entire set of codes from

a remote control, skip to the Batch Learning section on page xx.

1 Connect the MX-980 to your PC and verify that the ActiveSync icon in the lower right hand corner

of your PC screen is green.
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2 Select the button that you want to teach to by single clicking it on the simulator.



3 Click on the LEARN Tab or choose Learn from the Program. There will be a pause, while the PC

communicates with the MX-980, then the info window will display “Ready”.

The Learn Button re-activates

the Learning process when it

automatically times out or if

you want to re-learn a command.



The Learning Information

window prompts you when

the system is Ready to learn

a new command and when

a learned command is

Good, or if it Fails.



4 Press and hold the corresponding button on the original remote control while pointing it at the top

of the MX-980 (head to head) with the remotes approximately a half inch to an inch apart. When the

code is successfully learned, the window will say GOOD, confirming that the code learned “correctly.” Actually, the GOOD means that the code might be good.... You need to test it. Select the code

in the Current Learned IR List, then click on the TEST button while pointing the MX-980 at the

device.



TIP - Always POWER OFF the RF Base Station when testing Learned Codes. Test line-of-sight only!

If there is any interference or IR saturation, your tests will fail, not because of learning issues but

because of RF setup issues. Don’t waste time, test your codes now, test RF setup later.
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MX-980 Programming

Learning Manual

5 If the code doesn’t operate the component you can try the DoubleTap learning method. This is particularly useful for components using the Philips RC5 ‘togglebit” protocol. Many high end audio

companies use these codes. Just click on the 2 Time Learn radio button and you will be prompted to

learn every code twice.
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6 Click on SAVE - You must click on SAVE to save the LEARNED command. The blue “L” learned flag

appears on the button you taught the command to.
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Learning a Batch of Buttons Quickly

Using this method, MX-980 software will automatically save and select the next button, saving lots of time

when you are learning an entire remote control. Key to your success are two tips:



Tip #1 - Always label all your buttons before beginning

Tip #2 - Verify with one button that the codes from the new remote learn normally.

Once you’ve prepared, batch learning goes very quickly:

1 Select the STARTING Button - Select the button that is the top left of the buttons you want to teach

to. When MX-980 Editor automatically saves and selects the next button it moves left to right, unless

it is learning a group of buttons with similar functions. When you are batch learning the Volume

Group, MX-980 Editor first learns Volume Up, then Volume Down, then Mute, then advances to the

next group.

2 Select both the LEARN and the CONTINUE button - The combination activates the batch learning

capability of MXEditor. It is normal for MX-980 Editor to time out after learning the LCD page, and

again after learning the hard buttons. The CONTINUE button remains selected, but you must restart

the batch learning by selecting a new starting button on another LCD page or device, then selecting

LEARN again.
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3 Watch the LEARNING Window - When the info window says READY, press and hold the button on

the original remote control. When it says GOOD, release the button. If it says FAIL, reteach the same

command. When you see that a new button has been selected and the LEARNING window says

READY, then teach the new command from the original remote control.



Tip - To skip a buttons in the automatic sequence, select the next button you want.

Tip - You can test any code by selecting it on the simulator and clicking on the TEST button.

4 Remember to save your work, go to the File menu and select SAVE.
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Advanced IR Code Manipulation
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After learning of IR codes is complete, it’s time to download to the remote control and test all the learned codes.

Test, test, test ....Then you know it works, or not. If a code isn’t working one hundred percent of the time you can

either re-learn it or try to manipulate the IR code to get it to work.

To enter “Advanced IR Settings” select a button on a page and then double-click on the IR code in the “Macro” window.
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Double-click the IR code

in the Macro window

Adjusting the “Minimum Repeat When Pressed” setting

Minimum Repeat When Pressed: No matter how quick a button is pressed it will output “3” repeats at a minimum.

If you psychically press and hold the button, it will output commands until the button is released. “3” is the standard

repeat value for our remotes. If you are getting double commands for an IR code, ( “22” instead of “2”), lower the

repeat value to “2” which will resolve this issue. Normally you would not go higher.
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Creating a Sustained IR Command in a Macro - Adjusting the “Repeat”

Unchecking the “Repeat while button is pressed” box opens up the “Repeat” adjustment setting.

The “Repeat” adjustment setting will only output the specified number of repeats listed in the box no matter how

long the button is pressed for. This feature can be used with a component like a Projector, that need “2 seconds” of

continous IR output to turn on or off. You would uncheck the “Repeat while button is pressed” box and set the

“Projector On button” to repeat.Typically, most IR commands are about 7-15 repeats in one second.You’ll have to

experiment to find how many repeats equal how many seconds with each new component you try this with.

When the button is pressed, this macro step will output a string of 20 repeats and reliably turn on/off the projector.

Essentially, you are creating sustained burst (as if you were Pressing &amp; Holding the Projector On button) when you

this advanced IR code manipulation feature.
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Testing IR Codes after changing the Repeats

When you start changing IR Repeats, you must test to see if you’ve resolved the problem or made it worse.

Connect the MX-6000 to your computer, via the USB cable and click on the “Test” button to test the new IR code.

Experimentation will teach you what works best for different problem components. Make shure you add problem

compnents like projectors to your “Device Library”, so you only have to go through this process one time.
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Macro Programming



Bullet Proof Macros or Point N Pray?
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Professional Installations Require “Bullet-Proof” macros (all discrete codes or workarounds, no toggle

commands). A Point and Pray macro is created when you place a toggle command in the macro (like

a TV Power command). The use of Point &amp; Pray macros that only work if the customer follows strict

rules will create service calls and a lot of bad will (for example, you force the customer to verify that

the system is completely off before using the TURN ON macro). When you cannot find discrete

power commands, create an extra device called “POWER” or “SYSTEMPOWER” and give your client

one place to find all the power commands. Instruct them to power on their system manually from this

easy, convenient page, then return to WATCH or LISTEN to use the automated input switching Macros

for the ACTIVITIES like Watching CABLE, Watching a DVD movie etc. - For systems with lots of toggle Power codes, create a “Power”

HELP list.

In this example, the programmer has created a device called

SYSTEMPOWER. The client has

one convenient page to power

up their system manually.

Each button is labeled for the

power command the programmer has placed via the IR

Database Navigator.

This is much better technique

than programming a Point N

Pray Macro that will result in

much customer frustration.



Finding



Workarounds When There Are NO

Discrete Codes

By creatively experimenting you may find that you can workaround the lack of discrete codes. This takes time

and there is no guarantee that you will find a workaround for any given component. Here are some common

examples:

DVD and VCR Power Workaround

Most DVD players will turn on when off when they receive a Play command. Thus you can workaround like

this:

DVD ON = 1) Play

2) DVD Stop



DVD OFF = 1) Play

2) A delay of 2 to 4 seconds

3) DVD Power (toggle command)



TV scrolling “INPUT” Workarounds

Many televisions respond to a channel up or a channel number command by changing to the Antenna input

regardless of what input was last selected. This creates an “anchor” action that puts the television in a known

input. Thus you can create a workaround as follows:

EXAMPLE - CH Up takes TV to the ANT A input (and the TV has 5 inputs -Ant A, Ant B, EXT1, EXT2 and EXT3)
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4)
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Ch Up (takes TV to ANT A regardless of what input was last selected)

Input (takes TV to next input - ANT B)

Input (takes TV to next input - EXT 1)

Input (takes TV to next input - EXT 2)

Input (takes TV to desired input - EXT 3)



Using the Macro Window

The Macro Window controls macro recording as follows:



Record- Starts the macro recording

process.This enables you to simply navigate

to any page and click on a button to create

an “Alias” to it. An “Alias” is a copy of the

button’s IR command(s).



Stop - Click to stop Macro Recording

and save your work.



Delete - First select the step you want to

delete, then click on this button (or the

Delete key on the keyboard.



If/Else - This statement enables

you to program a decision into a

macro. So if your TV is currently

off, turn if on (send a power

command), else do nothing.



Test Macro - Play back your

macro by following these steps:



Sleep Timer - Select this option

to choose when to execute a

macro. The window will display

15 min, 30 min, 60 min, 90 min,

NOW, EXIT or CANCEL.



1) Select the first step in the

macro.

2) Connect to an MX-980
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3) Click on the TEST button.

Draggable Macro Steps - In this

window, you can view all of your

macro steps. You can click and

drag any step to any position,

changing the order of the macro.

Toggle - Toggle Macros are a

way of cycling through multiple

similar functions such as surround modes or favorite channels while using only one button

on the remote.



Delay - Click to open the

delay window. Any step can

be a delay between .1 and

30 seconds. Longer delays

can be created by using

more than one delay.



Jump - As the last step in a

Macro, you can specify a jump

to any page of any device. You

can program another jump in

the macro to display a page

with a status feedback message

or image.



Tip - All Buttons Can Be Macros except the Watch, Listen and

Page buttons.
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MX-980 Only - SET VARIABLE

Opens the Set Variable window,

which enables you to pick an

already-created variable and set it

to 0, 1 or to simply Invert its status.
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MX-980 Only - Text - Any step

can make the button label change.

If you want the label to stay

changed, insert a delay after the

text step to keep the text on for

enough time for your client to read

it.
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Programming a System Power On Macro

Set up your laptop and the connected remote within operational range of the home theater system

while programming a macro. Macros that the client will use to turn the system on require extensive

testing of delays and you can expect to do a lot of experimenting while programming.
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In this example, the WATCH device’s ON button is programmed to turn on the system, configure all

the Inputs and Modes for the client’s favorite activity, watching HDTV Cable TV.

1 In Tree View, navigate to the WATCH device. On the simulator, select the On button.



2 Click on the RECORD icon



or select Macro from the Program Menu.



3 In Tree View, expand all the pages of the devices you are

going to power on. Navigate to the first device you’d like to

turn on. Since the Plasma TV in the example system takes several seconds to warm up, it is the first device we’ll turn on.

With single clicks on the pages inside the Plasma TV device

we find the P-On command on Page 3.



4 On the simulator, click on the button with the device’s Power On command.



The new step appears in the Macro spread sheet:
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5 Program steps to power on the other components in the system. In this example, the cable box is

powered on all the time, since it is a DVR, so the only other component to power on is the surround

sound audio receiver.



6 Program steps to select the correct TV and Receiver input for the client’s favorite activity. In this

example the client’s favored activity is watching Cable TV. The cable box is connected to the TV

input of the Surround Sound receiver and the component output of the cable box is directly connected to the HDTV’s Video 3 input.



7 Program a jump to the Device and Page they use for their favorite activity.

Click on the JUMP icon.



8 Select the correct device and page from the Jump window. The jump appears in the Macro window

in the column under Jump.



9 Now, test if delays are necessary in your macro. First, turn the TV and the Receiver to the wrong

input, then turn off everything in the theater. Point the connected MX-980 at the system. Select the

first step in the list by clicking on it. Now, click on the TEST

the receiver. Did they both switch to the correct input?



button. Observe the television and



In the example system, the TV requires four seconds of warmup before the Input will correctly

change. The surround sound receiver requires two seconds, so we program a four second delay after

the TV and the Receiver power on.
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10 Select the Delay icon

, then when the delay window opens, click on the preset amount of delay

or enter any time between .1 second and 30 seconds.
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The new step appears in the list. Now, drag the delay step to the correct location.



TIP - Sometimes a change in order can provide the delay you need.

Each IR command lasts approximately 1/3 of a second, so if you have 3 commands, one second has

elapsed.

12 Again, turn the TV and the Receiver to the wrong input, then turn off everything in the theater. Point

the connected MX-980 at the system. Select the first step in the list by clicking on it. Now, click on

the TEST button. Observe the television and the receiver. Did they both switch to the correct input?

Continue to revise the macro with delays or changes until the macro ALWAYS correctly turns everything on and switches the surround sound receiver and television to the correct input. When the

macro is perfect, click on the STOP in the Macro Window.



13 Remember to save your work, click on SAVE in the File Menu.
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